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How	to	run	apk	on	android	emulator

How	to	run	apk	on	android	studio	emulator.	How	to	build	and	run	android	apk	on	emulator	using	dockerfile.	How	to	run	an	android	emulator.

The	Android	emulator	simulates	Android	devices	on	your	computer	so	you	can	test	the	application	on	a	variety	of	Android	API	devices	and	levels	without	having	to	have	each	physical	device.	The	emulator	provides	almost	all	the	functionality	of	a	real	Android	device.	You	can	simulate	incoming	phone	calls	and	text	messages,	specify	the	device	position,
simulate	different	network	speeds,	simulate	rotation	and	other	hardware	sensors,	access	Google	Play	Store	and	much	more.	Test	your	app	on	the	emulator	is	somewhat	fastest	and	easier	than	doing	it	on	a	physical	device.	For	example,	it	is	possible	to	transfer	the	data	faster	to	the	emulator	with	respect	to	a	device	connected	via	USB.	The	emulator	is
equipped	with	predefined	configurations	for	various	Android	phone	devices,	tablets,	Wear	OS	and	Android	TV	devices.	Watch	the	following	video	for	an	overview	of	some	emulator	features.	You	can	manually	use	the	emulator	through	its	graphical	user	interface	and	programmatically	through	the	command	line	and	the	emulator	console.	For	a
comparison	between	the	functions	available	through	each	interface,	see	Comparison	of	Android	emulator	tools.	Requirements	and	recommendations	The	Android	emulator	has	additional	requirements	beyond	the	basic	requirements	of	the	system	for	Android	Studio,	which	are	described	below:	STDK	Tools	26.1.1	or	version	of	the	higher	64-bit
processor:	CPU	with	UG	(Guest	Non	Restrictions)	Haxm	6.2.1	or	later	support	(HaxM	7.2.0	or	later	recommended)	Using	hardware	acceleration	has	additional	requirements	on	Windows	and	Linux:	Intel	processor	on	Windows	or	Linux:	Intel	processor	with	support	for	Intel	VT-X,	Intel	EM64T	(Intel	64)	and	Run	Disable	(XD)	Functionality	Bit	AMD
processor	on	Linux:	AMD	processor	with	support	for	AMD	Virtualization	(AMD-V)	and	additional	streaming	Simd	Extensions	3	(SSSE3)	AMD	processor	on	Windows:	Android	Studio	3.2	or	later	e	Next	version	for	Windows	10	April	2018	or	higher	for	Windows	functionality	of	the	Hypervisor	platform	(WHPX)	to	work	with	Android	8.1	(API	level	27)	and
higher	system	images,	a	connected	webcam	dev	And	have	the	ability	to	capture	720p	frames.	Ablioteca	for	32-bit	Windows	systems	The	Android	emulator	has	been	deprecated	in	June	2019	for	32-bit	Windows	systems.	The	support	for	the	32-bit	Windows	emulator	continues	until	2020	June,	including	critical	bug	fixes,	but	new	features	will	not	be
added.	If	you	use	the	emulator	on	a	32-bit	Windows	system,	you	must	plan	to	migrate	to	a	64-bit	Windows	system.	If	you	use	the	emulator	on	a	32-bit	Windows	system,	you	can	use	SDK	Manager	to	install	the	latest	version	of	the	32-bit	Windows	emulator.	Install	the	emulator	to	install	the	Android	emulator,	select	the	Android	emulator	component	in
the	SDK	Tools	tab	of	the	SDK	manager.	For	instructions,	see	Update	your	tools	using	the	SDK	manager.	Android	virtual	devices	Each	instance	of	the	Android	emulator	uses	an	Android	virtual	device	(AVD)	to	specify	the	Android	version	and	the	hardware	features	of	the	simulated	device.	To	effectively	test	your	app,	you	need	to	create	an	AVD	that
models	every	device	on	which	your	app	is	designed	to	run.	To	create	and	manage	AVD,	use	Avd	Manager.	Each	AVD	works	as	an	independent	device,	with	your	own	private	file	for	user	data,	the	SD	card	and	so	on.	By	default,	the	emulator	stores	the	user	data,	data	of	the	SD	card	and	the	cache	in	a	specific	directory	for	that	AVD.	When	you	start	the
emulator,	load	the	user	data	and	data	of	the	SD	card	from	the	AVD	directory.	Perform	an	app	on	the	Android	emulator	you	can	run	an	app	from	an	Android	Studio	project,	or	you	can	run	That	has	been	installed	on	the	Android	emulator	how	to	perform	any	app	on	a	device.	To	start	the	Android	emulator	and	run	an	app	in	your	project:	In	Android
Studio,	create	an	Android	virtual	device	(AVD)	that	the	emulator	can	use	to	install	and	run	your	app.	In	the	toolbar,	select	the	AVD	you	want	to	run	your	app	from	the	destination	device	drop-down	menu.	Click	Run.	If	you	receive	an	error	or	warning	message	to	the	Of	the	dialog	box,	click	the	link	to	correct	the	problem	or	to	get	more	information.
Some	errors	need	to	be	correct	before	you	can	continue,	like	some	errors	of	execution	of	Hardware	Accelerated	Execution	(Intel	HaxM).	For	MacOS,	if	you	see	a	notice:	No	DNS	server	has	found	an	error	when	starting	emulator,	check	if	you	have	a	/etc/resolv.conf	file.	If	you	do	not	have	this	file,	enter	the	following	command	in	a	terminal	window:	LN	-
S	/private/var/run/resolv.conf	/etc/resolv.conf	starts	the	Android	emulator	without	first	run	an	app	to	start	The	emulator:	while	the	emulator	is	running,	you	can	run	Android	Studio	projects	and	choose	the	emulator	as	a	destination	device.	You	can	also	drag	one	or	more	apk	to	the	emulator	to	install	them,	then	run	them.	Run	the	Android	emulator
directly	in	Android	Studio	Run	the	Android	emulator	directly	in	Android	Studio	to	quickly	store	the	property,	to	quickly	navigate	between	the	emulator	and	the	editor	window	using	the	shortcut	keys	and	to	organize	the	flow	of	IDE	and	emulator	work	in	a	single	application	window.	To	run	the	emulator	in	the	Android	studio,	make	sure	you	use	Android
Studio	4.1	or	higher	with	version	30.0.10	or	top	of	the	Android	emulator,	then	follow	these	steps:	Click	File>	Settings>	Tools>	Emulator	(or	Android	Studio	>	Preferences>	Tools>	Emulator	on	MacOS),	then	select	Start	in	a	Tool	window	and	click	OK.	If	the	emulator	window	is	not	displayed	automatically,	open	it	by	clicking	View>	Windows	Tool>
Emulator.	Start	your	virtual	device	using	Avd	Manager	or	positioning	it	when	you	run	your	app.	Limitations	Currently,	you	can	not	use	the	extended	emulator	controls	when	it	is	running	in	a	tool	window.	If	the	development	workflow	strongly	depends	on	extended	controls,	it	continues	to	use	the	Android	emulator	as	a	standalone	application.	Also,
some	virtual	devices	-	such	as	Android	TV	and	folding	devices	-	cannot	be	performed	in	Android	Study	because	they	have	specialized	UI	requirements	or	important	functions	in	extended	controls.	Install	and	Add	File	To	install	an	APK	file	on	the	emulated	device,	drag	an	APK	file	on	the	emulator	screen.	An	APK	Installer	dialog	box	appears.	At	the	end
of	the	installation,	you	can	view	the	app	in	the	list	of	apps.	To	add	a	file	to	the	emulated	device,	drag	the	file	on	the	emulator	screen.	The	file	is	inserted	in	/	sdcard	/	download	/	directory.	You	can	view	the	file	from	Android	Studio	using	the	device	file	explorer	or	find	it	from	the	device	using	the	download	or	app	app,	depending	on	the	version	of	the
device.	Snapshot	snapshot	is	a	stored	image	of	an	AVD	(Android	Virtual	Devices)	that	retains	the	entire	status	of	the	device	at	the	time	it	has	been	saved	Ã	¢	â,¬	"including	the	operating	system	settings,	the	application	status	and	the	user's	data.	You	can	return	to	a	saved	system	state	by	loading	a	snapshot	whenever	you	choose,	saving	the	waiting
time	of	the	operating	system	and	applications	on	the	virtual	device	to	restart,	in	addition	to	saving	you	the	effort	to	Return	your	app	to	the	state	to	which	you	want	to	resume	your	tests.	Starting	a	virtual	device	by	loading	a	snapshot	is	very	similar	to	wake	a	physical	device	from	a	state	of	suspension,	as	opposed	to	start	it	from	a	state	of	off.	For	each
Avd,	you	can	have	a	quick	start	snapshot	and	any	number	of	general	snapshots.	The	easiest	way	to	take	advantage	of	snapshots	is	to	use	quick	start	snaps:	by	default,	each	AVD	TO	To	automatically	save	a	quick	start-up	snapshot	on	the	output	and	charged	from	a	quick	snapshot	to	startup.	The	first	time	an	AVD	starts,	it	must	run	a	cold	start,	just	like
power	supply	on	a	device.	If	the	quick	start	is	enabled,	all	subsequent	start	the	load	from	the	specified	snapshot	and	the	system	is	restored	to	the	status	saved	in	that	snapshot.	The	snapshots	are	valid	for	the	system	image,	the	AVD	configuration	and	the	functions	of	the	emulator	with	which	they	are	saved.	When	making	a	change	in	any	of	these	areas,
all	instantaneous	AVD	snapshots	are	not	valid.	Any	update	to	the	Android,	Android	emulator,	The	Avd	image	or	settings	restores	the	saved	status	of	the	AVD,	then	the	next	time	the	AVD	starts,	it	must	run	a	cold	start.	Most	saving	controls,	loading	and	management	of	snapshots	are	in	the	instant	cards	and	in	the	settings	cards	in	the	instant	pane	in	the
Extended	Controls	Emulator	window.	You	can	also	check	the	quick	start	options	when	the	emulator	starts	from	the	command	line.	Save	Quick	Start	Instant	When	you	close	an	AVD,	you	can	specify	if	the	emulator	automatically	saves	a	snapshot	when	you	close.	To	check	this	behavior,	proceed	as	follows:	Open	the	Extended	Controls	Extended	Emulator
window.	In	the	category	of	control	snapshots,	go	to	the	Settings	tab.	Use	the	current	status	of	automatic	save	in	the	QuickBoot	drop-down	menu	to	select	one	of	the	following	options:	Yes:	Always	save	an	AVD	snapshot	when	you	close	the	emulator.	This	is	the	default	value.	Note:	When	automatic	quick	start	snapshots	are	enabled,	you	can	save	a	quick
start-up	snapshot	while	holding	down	the	Shift	key	when	the	emulator	closes.	No:	Do	​​not	save	an	avd	snapshot	when	the	emulator	closes.	Your	selection	applies	only	to	the	AVD	that	is	currently	open.	It	is	not	possible	to	save	snapshots	while	ADB	is	offline	(for	example	while	the	AVD	is	still	starting).	Save	General	Instant	While	You	can	only	have	a
quick	startup	snapshot	for	each	AVD,	you	can	get	more	general	snapshots	for	each	AVD.	To	save	a	general	snapshot,	open	the	Extended	Controls	Extended	Emulator	window,	select	the	instant	category	and	click	the	Take	Snapshot	button	in	the	lower	right	corner	of	the	window.	To	change	the	name	and	description	of	the	selected	snapshot,	click	the
Edit	button	at	the	bottom	of	the	window.	Delete	a	snapshot	to	manually	delete	a	snapshot,	open	the	Extended	Controls	Emulator	window,	select	the	instant	category,	select	the	snapshot	and	click	the	Delete	button	at	the	bottom	of	the	window.	You	can	also	specify	whether	you	want	the	emulator	to	automatically	delete	snapshots	when	they	become
invalid,	for	example	when	the	AVD	settings	or	the	emulator	version	change.	By	default,	the	emulator	will	ask	you	if	you	want	to	eliminate	invalid	instantaneous.	You	can	change	this	setting	with	the	Delete	invalid	snapshots	menu	on	the	Settings	tab	of	the	Instant	box.	Upload	a	snapshot	to	upload	a	snapshot	at	any	time,	open	the	Extended	Controls
Extended	Emulator	window,	select	the	instant	category,	select	a	snapshot	and	click	the	Load	button	at	the	bottom	of	the	window.	In	Android	Studio	3.2	and	later,	each	device	configuration	includes	a	startup	option	check	in	the	advanced	settings	in	the	Virtual	Device	Configuration	dialog	with	which	you	can	specify	which	instant	to	load	when	you	start
that	AVD.	Disable	Quick	Start	If	you	want	to	disable	quick	start	so	that	your	AVD	always	performs	a	cold	startup,	do	the	following:	Select	Tools>	Avd	Manager	and	click	Edit	this	AVD.	Click	Show	Advanced	Settings	and	scroll	down	on	the	emulated	performance.	Select	the	cold	boot.	Cold	start	once	instead	of	completely	disabling	quick	start,	you	can
only	start	only	one	time	by	clicking	Cold	Start	now	from	the	AVD	drop-down	menu	in	Avd	Manager.	Snapshot's	requirements	and	troubleshooting	snapshots	do	not	work	with	Android	4.0.4	(API	level	15)	or	lower.	Snapshots	do	not	work	with	Arm	system	images	for	Android	(API	level	26).	If	the	emulator	does	not	start	from	a	snapshot,	select	Cold	Start
now	for	Avd	in	Avd	Manager	and	send	a	bug	report.	Snapshots	are	not	reliable	when	software	rendering	is	enabled.	If	snapshots	do	not	work,	click	Edit	this	AVD	in	Avd	Manager	and	change	the	hardware	or	automatic	graphics.	Loading	or	rescue	a	snapshot	is	a	high-intensity	operation	of	memory.	If	you	do	not	have	enough	free	RAM	when	you	start	a
load	or	save	operation,	the	operating	system	may	exchange	the	RAM	content	on	the	hard	drive,	which	can	slow	down	the	operation.	If	you	experience	very	slow	loads	or	savories,	you	may	be	able	to	accelerate	these	operations	by	freeing	the	RAM.	Closing	applications	that	are	not	essential	for	your	work	is	a	good	way	to	free	up	free	Use	the	computer
mouse	pointer	to	imitate	your	finger	on	the	touchscreen;	Select	Menu	Elements	and	Input	Fields;	and	click	Buttons	and	Controls.	Use	the	computer	keyboard	to	enter	characters	and	insert	emulator	shortcuts.	Table	1.	Gestures	for	browsing	the	emulator	function	Description	Browse	the	screen	point	on	the	screen,	hold	down	the	main	mouse	button,
scroll	through	the	screen,	then	release.	Drag	an	item	point	to	an	item	on	the	screen,	press	and	hold	the	main	mouse	button,	move	the	item,	then	release.	Touch	(tap)	tip	on	the	screen,	press	the	main	mouse	button,	then	release.	For	example,	you	can	click	on	a	text	field	to	start	typing	in	it,	select	an	app	or	press	a	button.	Tap	twice	on	the	screen,
quickly	press	the	main	mouse	button	twice,	then	release.	Touch	and	hold	the	point	on	an	item	on	the	screen,	press	the	main	mouse	button,	press	and	hold,	then	release.	For	example,	you	can	open	options	for	an	object.	Type	it	is	possible	to	type	the	emulator	using	the	computer	keyboard	or	using	a	keyboard	that	opens	on	the	emulator	screen.	For
example,	you	can	type	a	text	field	after	selecting	it.	Pinch	and	Spread	Pressing	Control	(command	on	Mac)	brings	a	multi-touch	interface	of	pinch	gesture.	The	mouse	acts	as	the	first	finger,	and	through	the	anchor	point	is	the	second	finger.	Drag	the	cursor	to	move	the	first	point.	Clicking	the	left	button	of	the	left	mouse	button	How	to	tap	both	points,
and	releasing	acts	to	choose	both	up.	Scroll	vertical	Open	a	vertical	menu	on	the	screen	and	use	the	scroll	wheel	(mouse	wheel)	to	scroll	through	the	menu	items	until	the	desired	one	is	seen.	Click	on	the	menu	item	to	select	it.	Perform	common	actions	in	the	emulator	to	perform	common	actions	with	the	emulator,	use	the	panel	on	the	right	side,	as
described	in	Table	2.	You	can	use	keyboard	shortcuts	to	perform	many	common	actions	in	the	emulator.	For	a	complete	list	of	shortcuts	in	the	emulator,	press	F1	(Command	+	/	On	Mac)	to	open	the	Help	pane	in	the	Extended	Controls	window.	Table	2.	Common	actions	in	the	emulator	Description	Description	Close	Close	the	emulator.	Minimize	the
emulator	window	to	a	minimum.	Resize	resize	the	emulator	like	any	other	window	of	the	operating	system.	The	emulator	maintains	an	appropriate	aspect	ratio	for	your	device.	Ignition	Click	to	turn	on	or	deactivate	the	screen.	Click	and	hold	to	activate	or	deactivate	the	device.	Volume	up	Click	to	view	a	cursor	control	and	activate	the	volume.	Click
again	to	turn	it	up	more	or	use	the	cursor	control	to	change	the	volume.	Volume	down	Click	to	display	a	cursor	control	and	turn	the	volume	down.	Click	again	to	turn	it	more	or	use	the	cursor	control	to	change	the	volume.	Rotate	the	device	90	degrees	clockwise	to	the	left.	Rotate	the	device	90	degrees	clockwise	to	the	right.	Take	the	screenshot	click
to	take	a	device	screenshot.	For	details,	see	Screenshot.	Enter	the	zoom	mode	click	so	that	the	cursor	changes	into	the	zoom	icon.	To	exit	the	zoom	mode,	click	the	button	again.	Zoom	Next	and	Out	In	Zoom	Mode:	Click	the	left	button	on	the	screen	to	enlarge	25%,	up	to	a	maximum	of	about	twice	the	screen	resolution	of	the	virtual	device.	Right-click
to	enlarge.	Click	the	left	key	and	drag	to	select	a	box-shaped	area	for	Right-click	on	and	drag	a	selection	box	to	restore	the	default	zoom.	For	Pan	in	zoom	mode,	hold	the	control	(command	on	Mac)	while	pressing	the	arrow	keys	on	the	keyboard.	To	tap	the	device	screen	in	zoom	mode,	click	the	command	(click	on	the	command	on	Mac).	Back	Return
to	the	previous	screen	or	close	a	dialog	box,	an	options	menu,	notification	panel	or	on-screen	keyboard.	Home	Back	to	the	main	screen.	Overview	(recent	apps)	Touch	to	open	a	list	of	miniature	images	of	the	app	you	have	recently	worked.	To	open	an	app,	touch	it.	To	remove	a	thumbnail	from	the	list,	scroll	left	or	right.	This	button	is	not	supported	for
operating	system	wear.	Folding	folding	devices,	fold	the	device	to	view	its	smaller	screen	configuration.	Hanging	for	folding	devices,	explains	the	device	to	view	its	biggest	big	configuration.	Menu	Press	Control	+	M	(command	+	M	to	Mac)	to	simulate	the	MENU	button.	Other	Click	to	access	other	features	and	settings,	described	in	the	next	table.
Screen	registration	You	can	record	video	and	audio	from	the	Android	emulator	and	save	recording	to	a	WebM	or	an	animated	GIF	file.	Screen	recording	controls	are	in	the	Extended	Controls	window	record	card.	Tip:	You	can	also	open	screen	recording	controls	by	pressing	Control	+	Shift	+	R	(command	+	Shift	+	R	on	Mac).	To	start	recording	the
screen,	click	the	Start	Recording	button	in	the	Record	screen.	To	stop	recording,	click	Stop	Recording.	Controls	for	playback	and	saving	recorded	videos	are	at	the	bottom	of	the	screen	record	card.	To	save	the	video,	select	WebM	or	GIF	from	the	menu	at	the	bottom	of	the	card	and	click	Save.	It	is	also	possible	to	record	and	save	a	screen	recording
from	the	emulator	using	the	following	command	on	the	command	line:	ADB	EMU	ScreenRecord	Start	--Time-Limit	10	[Path	to	save	video]	/sample_video.Webm	Screenshots	to	take	a	screenshot	of	the	device	Virtual,	click	the	Take	Screenshot	button.	The	emulator	creates	a	PNG	file	with	the	name	screenshot_yyymmmdd-hhmms.png	using	the	year,
month,	day,	time,	the	minute	and	the	second	of	the	capture.	For	example,	screenshot_20160219-145848.png.	By	default,	the	screenshot	is	saved	on	your	desktop	computer.	To	change	the	location	where	screenshots	are	saved,	use	the	screenshot	saves	position	control	in	the	Settings	category	in	the	Extended	Controls	Emulator	Controls	window.	It	is
also	possible	to	shoot	screenshots	from	the	command	line	with	one	of	the	following	commands:	screenshot	screenshot	[Directory-Directory]	ADB	Emu	ScreenRecord	Screenshot	[Directory	Directory]	Camera	Support	The	emulator	supports	the	use	of	the	basic	camera	functionality	on	your	Virtual	device	for	Android	Previous	Versions.	Android	11	and
later	support	the	following	additional	Android	emulator	camera	features:	Arducted	Android	Capture	Yuv	Recoprocessioning	Level	3	Logical	Devices	Logic	Camera	Support	Emulating	Sensor	Orientation	Orientation	Using	data	from	the	sensor	manager	Application	of	video	stabilization	Reducing	the	frequency	of	hand	to	The	handshake	that	applies	the
improvement	of	the	edge	by	removing	the	overcharge	overload	the	virtual	scene	camera	of	the	YUV	pipeline	cameras	You	can	use	the	virtual	scene	camera	in	a	virtual	environment	to	experience	the	APP	Augmented	Reality	(AR)	made	with	Arcore	.	For	information	on	using	the	virtual	scene	camera	in	the	emulator,	see	Run	AR	Apps	in	the	Android
emulator.	When	using	the	emulator	with	a	camera	app,	you	can	import	an	image	in	PNG	or	JPEG	format	to	use	within	a	virtual	scene.	To	choose	an	image	for	use	in	a	virtual	scene,	click	Add	Image	in	the	Camera>	Virtual	Scenes	Pictures	in	the	Prolonged	Controls	window.	This	feature	can	be	used	to	import	custom	images	such	as	QR	codes	to	use	with
any	camera-based	app.	For	more	information,	see	Add	images	increased	on	the	scene.	Test	Common	actions	AR	with	macro	can	greatly	reduce	the	time	necessary	to	test	common	ar	actions	using	the	macros	preset	in	the	emulator.	For	example,	you	can	use	a	macro	to	restore	all	device	sensors	to	their	default	status.	Before	using	the	macros,	follow
the	steps	running	the	AR	Apps	in	Android	Emulator	to	configure	the	Of	the	virtual	scene	for	your	app,	run	your	app	on	the	emulator	and	update	arcore.	Then	follow	these	steps	to	use	emulator	macros:	with	the	running	emulator	and	your	app	connected	to	arcore,	click	More	in	the	Emulator	panel.	Select	Recording	and	Playback>	Macro	Playback.
Choose	a	macro	you	want	to	use,	then	click	Play.	During	playback,	you	can	interrupt	a	macro	by	clicking	Stop.	Extended	controls,	settings	and	guide	Use	extended	controls	to	send	data,	change	device	properties,	control	apps	and	more.	To	open	the	Extended	Controls	window,	click	More	in	the	Emulator	panel.	You	can	use	keyboard	shortcuts	to	run
many	of	these	activities.	For	a	complete	list	of	shortcuts	in	the	emulator,	press	F1	(Command	+	/	On	Mac)	to	open	the	Help	pane.	Guide.	3.	Extended	checks	Details	Function	Description	Location	The	emulator	allows	you	to	simulate	the	"My	Location"	information:	the	position	in	which	the	emulated	device	is	located.	For	example,	if	you	click	on	my
position	in	Google	Maps,	and	then	send	a	location,	the	Show	map.	The	controls	for	information	on	the	location	of	the	device	are	organized	in	two	tabs:	single	points	and	paths.	Single	points	in	the	Single	Steps	tab,	you	can	use	Google	Maps	WebView	to	look	for	points	of	interest,	just	as	you	should	use	Google	Maps	on	a	phone	or	browser.	When	you	are
looking	for	(or	click)	a	location	on	the	map,	you	can	save	the	location	by	selecting	Save	point	near	the	lower	part	of	the	map.	All	your	saved	locations	are	listed	on	the	right	side	of	the	Extended	Controls	window.	To	set	the	emulator	position	in	the	selected	location	on	the	map,	click	the	Set	position	button	at	the	bottom	right	of	the	extended	Controls
window.	Routes	similar	to	the	single	points	tab,	the	Routes	tab	provides	a	Google	Maps	WebView	that	you	can	use	to	create	a	path	between	two	or	more	places.	To	create	and	save	a	path,	do	the	following:	In	the	map	view,	use	the	Text	field	to	search	for	the	first	destination	in	the	route.	Select	the	position	from	the	search	results.	Select	the	Navigation
button.	Select	the	starting	point	of	your	path	from	the	map.	(Optional)	Click	Add	Destination	to	add	more	stops	to	the	route.	Save	your	route	by	clicking	Save	Path	to	view	the	map.	Specify	a	name	for	the	path	and	click	Save.	To	simulate	the	emulator	following	the	path	you	saved,	select	the	path	from	the	list	of	saved	routes	and	click	Play	the	Route
near	the	window	at	the	bottom	right	of	the	Extended	Controls	window.	To	interrupt	the	simulation,	click	Stop	Route.	To	simulate	the	emulator	continuously	following	the	specified	path,	enable	the	switch	next	to	repeat	playback.	To	change	the	speed	with	which	the	emulator	follows	the	specified	path,	select	an	option	from	the	playback	speed	drop-
down	menu.	Import	GPX	and	KML	data	to	use	geographical	data	from	a	GPS	(GPX)	exchange	file	or	KML	(Keyhokup	Markup	Language)	file:	click	Load	GPX	/	KML.	In	the	file	dialog	box,	select	a	file	on	your	computer	and	click	Open.	Optionally	select	a	speed.	The	default	speed	at	the	delay	value	(speed	1x).	You	can	increase	the	speed	with	double
(speed	2x),	triple	(3x	speed)	and	so	on.	Click	Run.	View	the	emulator	allows	you	to	distribute	your	multi-display	app,	which	support	customizable	sizes	and	can	help	you	test	the	apps	that	support	the	window	and	multi-display.	While	a	virtual	device	is	running,	you	can	add	up	to	two	additional	views	as	follows:	Add	another	display	by	clicking	Add
Secondary	View.	From	the	drop-down	menu	in	secondary	displays,	do	one	of	the	following:	Select	one	of	the	preset	appearance	reports.	Select	Custom	and	set	the	height,	width	and	DPI	for	the	custom	display.	(Optional)	Click	Add	Secondary	View	to	add	a	third	display.	Click	Apply	Changes	to	add	the	displays	specified	to	the	virtual	device	running.
Mobile	The	emulator	allows	you	to	simulate	various	network	conditions.	You	can	approximate	network	speed	for	different	network	protocols,	or	you	can	specify	the	full,	which	transfers	quickly	computer	data.	Specifying	a	network	protocol	is	increasingly	slow	than	the	full.	It	is	also	possible	to	specify	the	status	of	the	voice	and	data	network,	such	as
the	The	default	values	are	set	in	the	AVD.	Select	a	type	of	network:	GSM:	Global	System	For	Mobile	Communications	HSCSD:	High-speed	circuit	data	GPRS:	Generic	Packet	Radio	Service	Edge:	Mobile	data	handling	for	GSM	Evolution	UMTS:	Universal	Mobile	Telecommunications	System	HSPDA:	Buying	Access	Updale	purchase	LTE	LTE:	Complete
long-term	evolution	(default):	Use	the	network	supplied	by	the	computer	Select	a	signal	strength:	None	poor	moderate	(default)	Voucher	Select	a	voice	status,	a	data	status	or	both:	Home	(default)	Roaming	search	denied	(emergency	calls	only)	unregistered	battery	(deactivated)	can	simulate	the	owner	of	the	battery	of	Device	to	see	how	your	APP
performs	in	different	conditions.	To	select	a	charge	level,	use	the	cursor	control.	Select	a	battery	charger	connection	value:	Select	a	health	value	of	the	battery:	good	(default)	not	exhibited	Dead	overvoltage	overheated	smelling	Select	a	battery	status	value:	Unknown	charging	(default)	Discharge	Do	not	load	the	complete	phone	The	emulator	allows
you	to	Simulate	incoming	telephone	calls	and	text	messages.	To	start	a	call	to	the	emulator:	select	or	type	a	phone	number	in	the	field	from	the	field.	Click	on	call	device.	Optionally	click	on	Hold	Call	to	put	the	call	on	hold.	To	finish	the	call,	click	Finish	call.	To	send	a	text	message	to	the	emulator:	select	or	type	a	phone	number	in	the	field	from	the
field.	Type	a	message	in	the	SMS	message	field.	Click	Send	Message.	Directional	pad	If	the	AVD	has	the	directional	pad	enabled	in	the	hardware	profile,	you	can	use	the	directional	pad	commands	with	the	emulator.	However,	not	all	devices	can	support	the	directional	bearing;	For	example,	an	Android	watch.	The	buttons	simulate	the	following
actions:	fingerprint	This	control	can	simulate	10	different	scans	of	fingerprints.	You	can	use	it	to	test	the	integration	of	fingerprints	in	your	app.	This	function	is	disabled	for	Android	5.1	(API	level	22)	and	lower	and	for	the	wear	operating	system.	To	simulate	a	scanning	of	fingerprints	on	the	virtual	device:	Prepare	an	app	to	receive	a	fingerprint.	Select
a	fingerprint	value.	Click	Touch	Sensor.	Virtual	sensors>	Accelerometer	This	control	allows	you	to	test	your	app	against	changes	in	the	position	of	the	device,	orientation	or	both.	For	example,	you	can	simulate	gestures	as	inclination	and	rotation.	The	accelerometer	does	not	track	the	absolute	position	of	the	device:	it	simply	detects	when	a	change	is
occurring.	The	control	simulates	the	way	in	which	the	accelerometer	and	magnetometer	sensors	respond	when	moving	or	rotating	a	real	device.	You	need	to	enable	the	accelerometer	sensor	in	your	AVD	to	use	this	control.	The	control	shows	the	Type_Accelerometer	events	on	the	X	axis,	Y	and	Z.	These	values	​​include	gravity.	For	example,	if	the	device
is	suspended	in	the	outer	space,	it	would	try	zero	acceleration	(all	X,	Y	and	Z	will	be	0).	When	the	device	is	on	the	ground	and	laying	the	screen-up	on	the	top	of	a	table,	acceleration	is	0,	0	and	9.8	due	to	gravity.	The	control	also	reports	the	events	of	type_magnetic_field,	which	measure	the	environmental	magnetic	field	on	the	X,	Y	and	Z	axis	in
MICROTESLAS	(Î¼st).	To	rotate	the	device	around	X,	Y	and	Z	axes,	select	Rotate	and	do	one	of	the	following:	Adjust	Yaw,	Pitch	and	Roll	sliders	and	observe	the	position	in	the	upper	pane.	Move	the	device	representation	in	the	upper	pane	and	observe	the	yaw,	pitch	and	roll	and	the	way	in	which	the	resulting	accelerometer	values	​​change.	See
CONSTRUCTION	The	orientation	of	the	device	for	more	information	on	how	the	yaw,	pitch	and	roll	are	calculated.	To	move	the	device	horizontally	(X)	or	vertically	(Y),	select	Move	and	do	one	of	the	following:	Adjust	the	X	and	Y	sliders	and	observe	the	position	in	the	upper	pane.	Move	the	device	representation	in	the	upper	pane	and	observe	the	X	and
Y	cursor	values	​​and	how	the	resulting	accelerometer	values	​​change.	To	place	the	device	at	0,	90,	180	or	270	degrees:	in	the	rotation	area	of	​​the	device,	select	a	button	to	change	the	rotation.	When	adjusting	the	device,	i	resulting	values	change	accordingly.	These	are	the	values	that	an	app	can	access.	For	more	information	on	these	sensors,	see
Overview	of	sensors,	motion	sensors	and	position	sensors.	Virtual	sensors>	Additional	sensors	The	emulator	can	simulate	various	positions	and	environment	sensors.	Allows	you	to	adjust	the	following	sensors	so	you	can	test	them	with	your	app:	room	temperature:	This	environmental	sensor	measures	the	ambient	air	temperature.	Magnetic	field:	This
position	sensor	measures	the	environmental	magnetic	field	on	the	X,	Y	and	Z	axes,	respectively.	The	values	are	in	Microteslas	(Ã®	Â¼T).	Proximity:	this	position	sensor	measures	the	distance	from	an	object;	For	example,	you	can	notify	a	phone	that	a	face	is	close	to	make	a	call.	The	Sensor	must	be	enabled	in	your	AVD	to	use	this	control.	Light:	This
environmental	sensor	measures	the	illuminance.	The	values	​​are	in	Lux	Unit.	Pressure:	This	environmental	sensor	measures	the	ambient	air	pressure.	The	values	​​are	in	Millibar	Unit	(HPA).	Relative	humidity:	this	environmental	sensor	measures	the	relative	environmental	humidity.	For	more	information	on	these	sensors,	see	Overview	of	sensors,
position	sensors	and	environment	sensors.	Snapshots	see	instantaneous.	Screen	Record	See	screen	recording.	Settings>	General	theme	of	the	emulator	window:	select	the	light	or	the	darkness.	Send	keyboard	shortcuts	to:	By	default,	some	keyboard	combinations	will	affect	the	emulator	control	shortcuts.	If	you	develop	an	app	that	includes	a	link
keyboard,	for	example	a	targeted	to	devices	with	Bluetooth	keyboards,	you	can	change	this	setting	to	send	all	the	keyboard	inputs	to	the	virtual	device,	including	the	input	that	would	be	a	link	in	the	emulator	.	Screenshot	Save	Location:	Click	the	folder	icon	to	specify	a	location	to	save	the	screenshots	of	the	emulator	screen.	Use	the	detected	ADB
position:	if	you	run	the	emulator	from	Android	Studio,	you	need	to	select	this	setting	(the	default	value).	If	you	run	the	emulator	from	the	outside	Android	Studio	and	want	to	use	a	specific	ADB	program,	deselect	this	option	and	specify	the	location	of	SDK	tools.	If	this	setting	is	not	correct,	functionality	as	screenshot	capture	and	drag-and-drop	the
installation	of	the	app	will	not	work.	When	sending	anomalous	stop	reports:	always	select,	never,	or	ask.	Shows	the	window	frame	around	the	device:	By	default,	emulators	with	the	device's	skin	files	are	displayed	without	a	frame	of	the	surrounding	window.	Settings>	Proxy	By	default,	the	emulator	uses	the	Android	Studio	HTTP	proxy	settings,	but
this	screen	allows	you	to	manually	define	a	HTTP	proxy	configuration	for	the	emulator.	For	more	information,	see	using	the	emulator	with	a	proxy.	Settings>	Advanced	OpenGL	ES	Rendering:	Select	the	type	of	graphic	acceleration.	(This	is	equivalent	to	the	-GPU	command	line	option).	Host-based	Autodect:	Allows	the	emulator	Choose	hardware	or
software	graphics	acceleration	based	on	computer	configuration.	Check	if	the	GPU	driver	corresponds	to	a	list	of	known	defective	GPU	drivers	and,	if	it	does,	the	emulator	deactivates	the	graphic	hardware	emulation	and	instead	uses	the	CPU.	Angle:	(Windows	only)	Use	the	Direct3D	angle	to	make	graphics	in	software.	Swiftshader:	Use	SwiftShader
to	make	graphics	in	software.	Native	OpenGL	desktops:	Use	the	GPU	on	your	host	computer.	This	option	is	generally	the	fastest.	However,	some	drivers	have	problems	with	the	rendering	of	OpenGL	graphics,	so	it	may	not	be	a	reliable	option.	OpenGL	ES	API	Level:	Select	the	maximum	version	of	OpenGL	es	to	use	in	the	emulator.	Autoselect:	Allows
the	emulator	choose	the	OpenGL	ES	version	based	on	the	host	and	guest	support.	Maximum	rendering	(up	to	OpenGL	ES	3.1):	Try	to	use	the	maximum	version	of	OpenGL	es.	Compatibility	(OpenGL	ES	1.1	/	2.0):	Use	the	version	of	OpenGL	ES	compatible	with	most	environments.	Guide>	Keyboard	shortcuts	This	pane	provides	a	complete	list	of
keyboard	shortcuts	for	the	emulator.	To	open	this	panel	during	the	Emulator's	work,	press	F1	(Command	+	/	on	Mac).	For	job	shortcuts,	the	option	to	send	the	shortcut	keyboard	in	the	general	settings	panel	must	be	set	to	Emulator	(default)	controls.	Help>	Help	Emulator	to	go	to	Online	for	emulator,	click	Documentation.	To	open	a	bug	against	the
emulator,	click	Send	Feedback.	For	more	information,	see	how	to	report	emulator	bugs.	Help>	About	Language	ADB	brings	emulator	uses,	as	well	as	Android	and	emulator	version	numbers.	Compare	the	latest	version	of	the	emulator	available	with	the	version	to	determine	if	you	have	the	most	recent	installed	software.	The	emulator	serial	number	is
emulator-adb_port,	which	you	can	specify	as	an	ADB	command	line	option,	for	example.	Wi-Fi	When	using	an	AVD	with	API	25	or	higher	level,	the	emulator	provides	a	simulated	Wi-Fi	access	point	("AndroidWIFI"),	and	Android	automatically	automatically	automatically	now.	You	can	disable	Wi-Fi	in	the	emulator	by	emulator	with	the	command	line
parameter	-	Features	-WIFI.	Limitations	The	Android	emulator	does	not	include	virtual	hardware	for	the	following:	Bluetooth	NFC	SD	card	Distra	tab	card	/	Headphones	attached	to	the	USB	device	The	clock	emulator	for	wear	operating	system	does	not	provide	the	Overview	button	(recent	app),	D-pad	and	fingerprint	sensor.	Sensor.
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